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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard,
flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Product Name HP EliteBook 8470w Mobile Workstationl √  

 HP ProBook 8470p Notebook PC  √

Processors ● Intel® Quad Core® i7-3840QM 2.80-
GHz processor (SC turbo up to 3.80-
GHz; 1600-MHz FSB, 8.0-MB L3
cache, 45 W)

● Intel Quad Core i7-3820QM 2.70-GHz
processor (SC turbo up to 3.70-GHz;
1600-MHz FSB, 8.0-MB L3 cache,
45 W)

● Intel Quad Core i7-3740QM 2.70-GHz
processor (SC turbo up to 3.70-GHz;
1600-MHz FSB, 6.0-MB L3 cache,
45 W)

● Intel Quad Core i7-3720QM 2.60-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 6.0-MB L3 cache,
45 W)

● Intel Quad Core i7-3630QM 2.40-GHz
processor (SC turbo up to 3.40-GHz;
1600-MHz FSB, 6.0-MB L3 cache,
45 W)

● Intel Quad Core i7-3610QM 2.30-GHz
processor (SC turbo up to 3.30-GHz;
1600-MHz FSB, 6.0-MB L3 cache,
45 W)

√  
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Processors (continued) ● Intel Quad Core i7-3540M 3.00-GHz
processor (SC turbo up to 3.70-GHz;
1600-MHz FSB, 4.0-MB L3 cache,
35 W)

● Intel Dual Core i7-3520M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 4.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3380M 2.90-GHz
processor (SC turbo up to 3.60-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3360M 2.80-GHz
processor (SC turbo up to 3.50-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3340M 2.70-GHz
processor (SC turbo up to 3.40-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3320M 2.60-GHz
processor (SC turbo up to 3.30-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3320M 2.60-GHz
processor (SC turbo up to 3.20-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Dual Core i5-3210M 2.50-GHz
processor (SC turbo up to 3.10-GHz;
1600-MHz FSB, 3.0-MB L3 cache,
35 W)

● Intel Core i3-3130M 2.60-GHz
processor (1600-MHz FSB, 3.0-MB L3
cache, 35 W)

● Intel Core i3-3120M 2.50-GHz
processor (1600-MHz FSB, 3.0-MB L3
cache, 35 W)

● Intel Core i3-3110M 2.40-GHz
processor (1600-MHz FSB, 3.0-MB L3
cache, 35 W)

√ √

Processors (continued) ● Intel Core i3-2370M 2.40-GHz
processor (1333-MHz FSB, 3.0-MB L3
cache, 35 W)

● Intel Celeron B840 1.90-GHz
processor (1333-MHz FSB, 2.0-MB L3
cache, 35 W)

 √

Chipset Mobile Intel QM77 chipset √ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Graphics Switchable discrete graphics: AMD
FirePro™ M2000 (64-bit), with 1024-MB
GDDR5 (64-MB × 32,1.5V, 5-GBPS,
quantity 4); supports open GL

√  

 Switchable discrete graphics: AMD
Radeon™ HD 7570M (64-bit), with 1024-
MB GDDR5 (64-MB × 32,1.5V, 5-GBPS,
quantity 4)

Internal graphics:

● Universal memory architecture (UMA)
with shared video memory

● Intel HD Graphics 4000

 √

 ● Support for dual-display ports through
docking station

● Support for DisplayPort 1.2 (only on
computer models equipped with a
graphics subsystem with
discrete memory)

● Support for up to 4 displays through
the APR (only on computer models
equipped with a graphics subsystem
with discrete memory)

√ √

Panel ● 14.0-in light-emitting diode (LED),
high-definition+ (HD+), AntiGlare (AG),
SVA (1600×900) display with and
without webcam and microphone

● 14.0-in LED, HD, AG, SVA (1366×768)
display with and without webcam and
microphone

All display assemblies include two wireless
local area network (WLAN) antenna cables
and two wireless wide area network
(WWAN) antenna cables

Supports low voltage differential
signalling (LVDS)

Supports 16:9 aspect ratio

Supports privacy filter

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Memory Two customer-accessible/upgradable
memory module slots

DDR3-1600-MHz dual channel support

Supports 16384-MB of system RAM in the
following configurations:

● 16384-MB (8192-MB×2)

● 8192-MB (8192-MB×1 or 4096×2)

● 8192-MB (8192-MB×1 or 4096×2; not
supported on computer models
equipped with a 32-bit
operating system)

● 6144-MB (4096-MB+2048-MB)

● 4096-MB (4096-MB×1 or 2048-MB×2)

● 2048-MB (2048×1)

√ √

Flash cache Intel 24-GB mSATA module (Intel Smart
Response Technology (SRT), not available
on computer models equipped with WWAN
or SSD)

√ √

Hard drive Supports 6.35-cm (2.5-in) hard drives in
9.5-mm (.37-in) and 7.0-mm (.28-in)
thicknesses (all hard drives use the
same bracket)

Customer-accessible

Serial ATA

Supports the following hard drives:

● 750-GB, 7200-rpm, 9.5-mm

● 500-GB, 7200-rpm, 7.0-mm self-
encrypting drive (SED)

● 500-GB, 7200-rpm, 7.0-mm

● 320-GB, 7200-rpm, 7.0-mm

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Solid-state drive Solid-state drive (SSD) mounts in the same
bracket as the hard drive

Customer-accessible

Serial ATA III

Supports the following SSDs:

● 256-GB SED

● 240-GB

● 180-GB

● 160-GB

● 128-GB

√  

Upgrade drive Customer-accessible

Supports the following drive options:

● Blu-ray R/RE DVD±RW SuperMulti
DL Drive

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

● 500-GB, 7200-rpm, 9.5-mm

Supports no drive option

√  

Upgrade bay
(continued)

Customer-accessible

Supports the following drive options:

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

● 500-GB, 7200-rpm, 9.5-mm

Supports no drive option

 √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Optical drive Fixed

Serial ATA

12.7-mm tray load

Supports the following optical drives:

● Blu-ray R/RE DVD±RW SuperMulti
DL Drive

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

Supports zero power optical drive

√  

 Fixed

Serial ATA

12.7-mm tray load

Supports the following optical drives:

● Blu-ray ROM DVD±RW SuperMulti
DL Drive

● DVD±RW Double-Layer with
SuperMulti Drive

● DVD-ROM Drive

Supports zero power optical drive

 √

Audio and video Two stereo speakers √ √

 HD audio with SRS Premium Sound PRO √ √

Audio and video
(continued)

Integrated 720p HD webcam (supports no
camera option)

√ √

 Integrated dual-array microphone on
computer models equipped with a webcam

Integrated mono microphone on computer
models not equipped with a webcam

√ √

Modem 56kbps v.92 MDC data/fax modem module

Supports no modem option

Modem module cable not included

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Ethernet Intel 82579LM 10/100/1000 Ethernet
network interface card (NIC) with
iAMT Intel 82579LM Gigabit
Network Connection

NIC Power Down technology

S3/S4/S5 wake on LAN

Ethernet cable not included

√ √

Wireless Integrated wireless personal area network
(WPAN) option by way of Bluetooth 4.0
enhanced data rate (EDR) module

Supports no WPAN option

√ √

 Integrated wireless local area network
(WLAN) options by way of wireless module

Three WLAN antennas built into
display assembly

Support for the following WLAN formats:

● Atheros WB225 1×1 802.11b/g/n
Bluetooth Combo Adapter

● Broadcom 43228 802.11abgn 2×2 Wi-
Fi Adapter

● Intel Centrino Advanced-N 6205
Combo Adapter

● Intel Centrino Advanced-N 6205
WLAN module

● Intel Centrino Ultimate-N 6300
WLAN module

● Intel Centrino Wireless-N 2200
802.11b/g/n 2×2 WiFi Adapter

Supports no WLAN option

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Wireless (continued) Integrated wireless wide area network
(WWAN) options by way of wireless module

Two world-wide/5-band WWAN antennas
built into display assembly

Secured by subscriber identity module
(SIM, user-accessible behind battery)

Support for the following WWAN formats:

● HP hs2350 HSPA+ Mobile
Broadband Module

● HP lt2523 LTE/HSPA+ Mobile
Broadband Module

● HP un2430 EV-DO/HSPA Mini Card

● HP lt2522 LTE/EV-DO Mobile
Broadband Module

● HP un2430 EV-DO/HSPA Mini Card

● HP un2430 EV-DO/HSPA Mobile
Broadband Module

Supports no WWAN option

Supports WWAN after market option

√ √

External media cards Integrated 54-mm ExpressCard

Secure Digital (SD) flash media slot with
push-push technology, supporting the
following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Ports ● 1394a port

● Audio-in (mono microphone)

● Audio-out (stereo headphone)

● Battery connector

● DisplayPort 1.2 (on computer models
equipped with a graphics subsystem
with discrete memory)

● DisplayPort 1.1a (on computer models
equipped with a graphics subsystem
with UMA memory)

● Docking connector

● eSATA/USB 2.0 combo port

● HP Smart AC adapter

● RJ-45 (Ethernet)

● RJ-11 (modem)

● Secondary battery connector

● Serial port

● USB 3.0 ports (2)

● USB 2.0 port

● USB 2.0 charging port

● VGA (Dsub 15 pin) supporting:
1920×1200 external resolution @
75 Hz, hot plug and unplug and
autodetection for correct output to
wide-aspect vs. standard aspect video

√ √

Keyboard/pointing
devices

Full-size keyboard with numeric keypad
(upper-left justified), dual-point, spill-
resistant, chiclet-style, with durakeys

√ √

 Gesture support: MultiTouch gestures
enabled, two-finger scrolling, and pinch-
zoom as default

√ √

 Taps enabled by default √ √

 Support for TouchPad with image sensor √ √

 Support for Windows 8 Indirect Touch √ √

Power requirements Supports the following HP Smart AC adapters:

Power requirements
(continued)

● 90-W HP Smart AC adapter (PFC,
EM, 3-wire)

√ √

 ● 90-W HP Smart AC adapter (PFC, 3-
wire)

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

 ● 65-W HP Smart AC adapter (non-PFC,
3-wire)

√ √

 ● 65-W HP Smart AC adapter (RC/V,
EM, 3-wire)

√ √

 Supports the following batteries:

● 9-cell, 100-Wh, 3.0-Ah battery

● 9-cell, 73-Wh, 2.2-Ah battery

● 6-cell, 62-Wh, 2.8-Ah battery

● 6-cell, 55-Wh, 2.8-Ah battery

● 3-cell, 31-Wh, 2.8-Ah battery

√ √

Security Supports security cable lock √ √

 Supports fingerprint reader and no
fingerprint reader option

√ √

 Supports Trusted Platform Module (TPM)
1.2 (Infineon, soldered down) and
TPM Enhanced Drive Lock (not supported
in Asia and the People's Republic of China)

√ √

 Integrated Smart Card reader (active) √ √

 Full volume encryption √ √

 Preboot authentication (password,
Smart Card)

√ √

Operating system Preinstalled:

● Windows® 8 ML 64 with Microsoft
Basics (Japan only)

● Windows 8 Professional 64 with
Microsoft Basics (Japan only)

● Windows 8 Professional 64 DPK with
Windows 7 Professional 64 and 32
(Japan only)

● Windows 7 Home Premium 64 and 32
with Microsoft Basics

● Windows 7 Professional 64 and 32
with Microsoft Basics

● Windows 7 Service Pack 1

● FreeDOS

● SUSE Linux (SLED; People's Republic
of China only)

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

 Preinstalled with Microsoft Office:

● Windows 8 CH 64-bit with Office 2010
Transition OPK (People's Republic of
China only)

● Windows 8 EM 64-bit with Office 2010
Transition OPK (not available
in Japan)

● Windows 8 ML 64-bit with Office 2010
Business and Home (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 ML 64-bit with Office 2010
Personal (Japan only; requires
configuration with Office Personal
Japan 2010 app AV)

● Windows 8 ML 64-bit with Office 2010
Professional (Japan only; requires
configuration with Office Personal
Japan 2010 app AV)

● Windows 8 ML 64-bit with Office 2010
Transition OPK (not available
in Japan)

(Continued)
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Operating system
(continued)

Preinstalled with Microsoft Office:
(continued)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Business and
Home (Japan only; requires
configuration with Office Personal
Japan 2010 app AV)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Personal
(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Professional
(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

● Windows 8 Professional 64-bit DPK
with Windows 7 Professional 64- and
32-bit with Office 2010 Starter (not
available in Asia-Pacific countries and
regions, Japan, or the People's
Republic of China)

● Windows 8 Professional 64-bit with
Office 2010 Business and Home
(Japan only; requires configuration
with Office Personal Japan 2010 app
AV)

● Windows 8 Professional 64-bit with
Office 2010 Personal (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit with
Office 2010 Professional (Japan only;
requires configuration with Office
Personal Japan 2010 app AV)

● Windows 8 Professional 64-bit with
Office 2010 Transition OPK (not
available in Japan)

● Windows 7 Home Basic 32-bit with
Office Starter (emerging markets only)

(Continued)

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Operating system
(continued)

Preinstalled with Microsoft Office:
(Continued)

● Windows 7 Home Premium 64- and
32-bit with Office Starter (not available
in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Home & Business (only
in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with
Office 2010 Professional (only
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Starter (not available
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Business & Home
(only in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Personal (only
in Japan)

● Windows 7 Professional 64- and 32-bit
with Office 2010 Professional (only
in Japan)

√ √

 Restore media—DR-DVD:

● Windows 8 (available with any
Windows 8 operating system and
required with Windows 8 Professional
64-bit DPK with Windows 7 image)

● Windows 7 (available with any
Windows 7 HP, Windows 7
Professional loc, Windows 7 HB, or
Windows 8 Professional 64-bit DPK
with Windows 7 image)

√ √
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Category Description HP EliteBook 8470w
Mobile Workstation

HP EliteBook 8470p
Notebook PC

Operating system
(continued)

Restore media—OS-DVD:

● Windows 8 Professional 64-bit
(required with Windows 8 Professional
64-bit DPK with Windows image)

● Windows 7 Home Basic 32-bit
(available with any Windows 7 Home
Basic location except Asia-Pacific
countries and regions and the People's
Republic of China)

● Windows 7 Home Premium 64- and
32-bit (available with any Windows 7
Premium location except Asia-Pacific
countries and regions and the People's
Republic of China)

● Windows 7 Professional 64- and 32-bit
(available with any Windows 7
Professional or Windows 8
Professional 64-bit DPK with Windows
image location except Asia-Pacific
countries and regions and the People's
Republic of China)

√ √

 Certified:

● Microsoft WHQL

● SuSE Linux Enterprise (SLED) 64-bit
Service Pack 2

√ √

Operating system
(continued)

Web-only support:

● Windows XP Pro 32-bit

● Windows 7 Enterprise 64- and 32-bit

● Windows 7 Ultimate 64- and 32-bit

√ √

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Keyboard

● Memory module

● mSATA drive

● Optical drive

● Solid-state drive

● WLAN module

● WWAN module

√ √
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2 External component identification

Display

Item Component Description

(1) Internal display switch Turns off the display or initiates Suspend if the display is
closed while the power is on.

NOTE: The display switch is not visible from the
outside of the computer.

(2) WLAN antennas (3)* Send and receive wireless signals to communicate
with WLANs.

(3) Internal microphones (2) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.

(5) Webcam (select models only) Records video and captures still photographs.

(6) Keyboard light button Turns the keyboard light on or off.

Display 15



Item Component Description

(7) Keyboard light Illuminates the keyboard, especially in low-
light conditions.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety,
and Environmental Notices that applies to your country or region.
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Buttons and fingerprint reader (select models only)
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad on/off button Turns the TouchPad on and off.

(2) Power button ● When the computer is off, press the button to turn
on the computer.

● When the computer is on, press the button briefly
to initiate Suspend.

● When the computer is in the Suspend state, press
the button briefly to exit Suspend.

● When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and operating
system shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings:

● Windows 8—From the Start screen, type power,
select Settings, and then select Power Options.

● Windows 7:

1. Select Computer > Control Center.

2. In the left pane, click System, and then click
Power Management in the right pane.

(3) Wireless button Turns the wireless feature on or off but does not
establish a wireless connection.

Buttons and fingerprint reader (select models only) 17



Item Component Description

(4) Web browser button ● When the computer is on, press the button to open
the default Web browser.

● When the computer is off, in the Suspend state, or
in Hibernation, the button does not perform any
action or function.

(5) Volume mute button Mutes and restores speaker sound.

(6) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Function keys Execute frequently used system functions when pressed
in combination with the fn key.

(2) fn key Executes frequently used system functions when
pressed in combination with a function key.

(3) Operating system logo key Displays the operating system menu.

(4) Operating system applications key Displays a shortcut menu for items beneath the cursor.

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

Each key on the keypad performs the function indicated
by the icon in the upper-right corner of the key.

(6) num lk key Turns the embedded numeric keypad on and off when
pressed in combination with the fn key.
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Lights
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) TouchPad light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.

(2) Caps lock light ● On: Caps lock is on.

● Off: Caps lock is off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Suspend state.

● Off: The computer is off or in Hibernation.

(4) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(5) Web browser light ● On: The computer is on.

● Off: The computer is off, in the Suspend state, or
in Hibernation.

(6) Mute light ● Amber: Computer sound is off.

● Off: Computer sound is on.

(7) Num lock light On: Num lock is on.

TouchPad
NOTE: Your computer may look slightly different from the illustration in this section.
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Item Component Description

(1) Pointing stick (select models only) Moves the pointer and selects or activates items on
the screen.

(2) Left pointing stick button (select
models only)

Functions like the left button on an external mouse.

(3) TouchPad on/off button Turns the TouchPad on or off.

(4) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(5) Left TouchPad button Functions like the left button on an external mouse.

(6) Right TouchPad button Functions like the right button on an external mouse.

(7) Right pointing stick button (select
models only)

Functions like the right button on an external mouse.
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Front
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Display release latch Opens the computer.

(2) Wireless light ● White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(3) Power light ● On: The computer is on.

● Blinking: The computer is in the Suspend state.

● Off: The computer is off or in Hibernation.

(4) AC adapter/Battery light ● Amber: The computer is connected to external
power and the battery is charged from 0 to
90 percent.

● White: The computer is connected to external
power and the battery is charged from 90 to 99
percent.

● Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level,
the battery light begins blinking rapidly.

● Off: The battery is fully charged.

(5) Hard drive light ● Blinking white: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(6) Speakers (2) Produce sound. One of the speakers is on the bottom of
the computer, and it cannot be seen from the front of
the computer.

Front 21



Left side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Power connector Connects an AC adapter.

(2) 1394 port Connects an optional IEEE 1394 or 1394a device, such
as a camcorder.

(3) USB 3.0 ports (2) Connect optional USB 3.0 devices and provide
enhanced USB power performance.

(4) HP ExpressCard slot or Smart Card reader
(depending on configuration)

Supports optional ExpressCards or smart cards.

(5) Media Card Reader Supports the following digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

(6) Upgrade bay (optical drive shown) The upgrade bay can hold a weight-saver option, a hard
drive, or an optical drive that reads an optical disc.

NOTE: On select models, the optical drive also writes
to an optical disc.

(7) Optical drive eject button (select
models only)

Releases the disc tray.
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Right side
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Audio-out (headphone) jack Produces sound when connected to optional powered
stereo speakers, headphones, earbuds, a headset, or
television audio. Also connects an optional
headset microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and
Environmental Notices.

NOTE: When a device is connected to the jack,
the computer speakers are disabled.

(2) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3) Smart Card reader Supports optional smart cards.

(4) eSATA/USB 2.0 port Connects an optional high-performance eSATA
component, such as an eSATA external hard drive, or
connects an optional USB device.

(5) USB charging port Connects an optional USB device. The USB charging
port can also charge select models of cell phones and
MP3 players, even when the computer is off.

(6) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.

(7) Vents (2) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from
being mishandled or stolen.
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Rear
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) RJ-11 (modem) jack Connects a modem cable.

(2) External monitor port Connects an external VGA monitor or projector.

(3) RJ-45 (network) jack Connects a network cable.
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Bottom
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Vents (4) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(2) Battery release latch Releases the battery.

(3) Docking connector Connects an optional docking device.

(4) Service cover release latch Releases the service cover from the computer.

(5) Battery bay Holds the battery.

(6) Accessory battery connector Connects an optional accessory battery.

(6) Speakers (2) Produce sound.
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Item Component Description

(7) Bluetooth compartment Contains a Bluetooth device (select models only).

(8) Service cover Provides access to the hard drive, and also contains the
WLAN module slot and the memory module slots.

CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country
or region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag. It is necessary to remove the battery to obtain these numbers.
See Battery Battery on page 67 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.
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Item Description Function

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Computer major components
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 38.

(2) Keyboard with pointing stick for use only on HP EliteBook 8470w Mobile Workstation computer models (includes
keyboard cable and pointing stick cable):

 For use only on computer models equipped with the Windows 8 operating system:

 For use in Belgium 702649-A41

 For use in Brazil 702649-201

 For use in Bulgaria 702649-261

 For use in Canada 702649-DB1

 For use in the Czech Republic and Slovakia 702649-FL1

 For use in Denmark 702649-081

 For use in France 702649-051

 For use in Germany 702649-041

 For use in Greece 702649-151

 For use in Hungary 702649-211

 For use in Iceland 702649-DD1

 For use in India 702649-D61

 For use in Israel 702649-BB1

 For use in Italy 702649-061

 For use in Japan 702649-291

 For use in Latin America 702649-161

 For use in the Netherlands 702649-B31

 For use in Norway 702649-091

 For use in Northwest Africa 702649-FP1

 For use in Portugal 702649-131

 For use in Romania 702649-271

 For use in Russia 702649-251

 For use in Saudi Arabia 702649-171

 For use in Slovenia 702649-BA1

 For use in South Korea 702649-AD1

 For use in Spain 702649-071

 For use in Sweden and Finland 702649-B71

 For use in Switzerland 702649-BG1

 For use in Taiwan 702649-AB1

 For use in Thailand 702649-281

30 Chapter 3   Illustrated parts catalog



Item Component Spare part number

 For use in Turkey 702649-141

 For use in the United Kingdom and Singapore 702649-031

 For use in the United States 702649-001

 For use only on computer models equipped with the Windows 7 operating system:

 For use in Belgium 686300-A41

 For use in Brazil 686300-201

 For use in Bulgaria 686300-261

 For use in Canada 686300-DB1

 For use in the Czech Republic and Slovakia 686300-A81

 For use in Denmark 686300-081

 For use in France 686300-051

 For use in Germany 686300-041

 For use in Greece 686300-DJ1

 For use in Hungary 686300-211

 For use in Iceland 686300-DD1

 For use in India 686300-D61

 For use in Israel 686300-BB1

 For use in Italy 686300-061

 For use in Japan 686300-291

 For use in Latin America 686300-161

 For use in the Netherlands 686300-B31

 For use in Norway 686300-091

 For use in Northwest Africa 686300-FP1

 For use in Portugal 686300-131

 For use in Romania 686300-271

 For use in Russia 686300-251

 For use in Saudi Arabia 686300-171

 For use in Slovenia 686300-BA1

 For use in South Korea 686300-AD1

 For use in Spain 686300-071

 For use in Sweden and Finland 686300-B71

 For use in Switzerland 686300-BG1

 For use in Taiwan 686300-AB1

 For use in Thailand 686300-281
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Item Component Spare part number

 For use in Turkey 686300-141

 For use in the United Kingdom and Singapore 686300-031

 For use in the United States 686300-001

 Keyboard with pointing stick for use only on HP EliteBook 8470p Notebook PC computer models (includes
keyboard cable and pointing stick cable):

 For use only on computer models equipped with the Windows 8 operating system:

 For use in Belgium 702651-A41

 For use in Brazil 702651-201

 For use in Bulgaria 702651-261

 For use in Canada 702651-DB1

 For use in the Czech Republic and Slovakia 702651-FL1

 For use in Denmark 702651-081

 For use in France 702651-051

 For use in Germany 702651-041

 For use in Greece 702651-151

 For use in Hungary 702651-211

 For use in Iceland 702651-DD1

 For use in India 702651-D61

 For use in Israel 702651-BB1

 For use in Italy 702651-061

 For use in Japan 702651-291

 For use in Latin America 702651-161

 For use in the Netherlands 702651-B31

 For use in Norway 702651-091

 For use in Northwest Africa 702651-FP1

 For use in Portugal 702651-131

 For use in Romania 702651-271

 For use in Russia 702651-251

 For use in Saudi Arabia 702651-171

 For use in Slovenia 702651-BA1

 For use in South Korea 702651-AD1

 For use in Spain 702651-071

 For use in Sweden and Finland 702651-B71

 For use in Switzerland 702651-BG1

 For use in Taiwan 702651-AB1
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Item Component Spare part number

 For use in Thailand 702651-281

 For use in Turkey 702651-141

 For use in the United Kingdom and Sinapore 702651-031

 For use in the United States 702651-001

 For use only on computer models equipped with the Windows 7 operating system:

 For use in Belgium 686299-A41

 For use in Brazil 686299-201

 For use in Bulgaria 686299-261

 For use in Canada 686299-DB1

 For use in the Czech Republic and Slovakia 686299-FL1

 For use in Denmark 686299-081

 For use in France 686299-051

 For use in Germany 686299-041

 For use in Greece 686299-DJ1

 For use in Hungary 686299-211

 For use in Iceland 686299-DD1

 For use in India 686299-D61

 For use in Israel 686299-BB1

 For use in Italy 686299-061

 For use in Japan 686299-291

 For use in Latin America 686299-161

 For use in the Netherlands 686299-B31

 For use in Norway 686299-091

 For use in Northwest Africa 686299-FB1

 For use in Portugal 686299-131

 For use in Romania 686299-271

 For use in Russia 686299-251

 For use in Saudi Arabia 686299-171

 For use in Slovenia 686299-BA1

 For use in South Korea 686299-AD1

 For use in Spain 686299-071

 For use in Sweden and Finland 686299-B71

 For use in Switzerland 686299-BG1

 For use in Taiwan 686299-AB1
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Item Component Spare part number

 For use in Thailand 686299-281

 For use in Turkey 686299-141

 For use in the United Kingdom and Singapore 686299-031

 For use in the United States 686299-001

(3) Top cover (includes TouchPad):

 Equipped with pointing stick buttons and a fingerprint reader for use only on HP
EliteBook 8470w Mobile Workstation computer models

686043-001

 Equipped with pointing stick buttons and a fingerprint reader for use only on HP
EliteBook 8470p Notebook PC computer models

686964-001

 Equipped with pointing stick buttons but not a fingerprint reader for use only on HP
EliteBook 8470p Notebook PC computer models

686965-001

(4) Smart Card reader 686025-001

(5) Display lid switch board (includes cable) 684340-001

(6) Fingerprint reader board (includes cable) 684343-001

(7) RTC battery 651948-001

(8) ExpressCard assembly 684345-001

(9) System board (includes replacement thermal material):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 8 Professional operating system in all countries and
regions except the People's Republic of China and the Ukraine

686042-601

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 8 Standard operating system in all countries and regions
except the People's Republic of China and the Ukraine

686042-501

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 7 operating system in all countries and regions except the
People's Republic of China and the Ukraine

686042-001

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 7 operating system in the People's Republic of China and
the Ukraine

691718-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 8 Professional operating system in all countries and
regions except the People's Republic of China and the Ukraine

686041-601

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 8 Standard operating system in all countries and regions
except the People's Republic of China and the Ukraine

686041-501

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 7 operating system in all countries and regions except the
People's Republic of China and the Ukraine

686041-001

 For use only on computer models equipped with a graphics subsystem with discrete
memory and the Windows 7 operating system in the People's Republic of China and
the Ukraine

691717-001
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Item Component Spare part number

 For use only on computer models equipped with a graphics subsystem with UMA
memory and the Windows 8 Professional operating system in all countries and
regions except the People's Republic of China and the Ukraine

686040-601

 For use only on computer models equipped with a graphics subsystem with UMA
memory and the Windows 8 Standard operating system in all countries and regions
except the People's Republic of China and the Ukraine

686040-501

 For use only on computer models equipped with a graphics subsystem with UMA
memory and the Windows 7 operating system in all countries and regions except the
People's Republic of China and the Ukraine

686040-001

 For use only on computer models equipped with a graphics subsystem with UMA
memory and the Windows 7 operating system in the People's Republic of China and
the Ukraine

691716-001

(10) Modem module

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number
641830-001.

628824-001

(11) WLAN module:

 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

 Intel Centrino Advanced-N 6205 Combo Adapter 695915-001

 Intel Centrino Ultimate-N 6300 WLAN module 572511-001

 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter 670288-001

(12) Processor (includes replacement thermal material):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80-GHz; 1600-
MHz FSB, 8.0-MB L3 cache, 45 W)

703266-001

 Intel Quad Core i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-
MHz FSB, 8.0-MB L3 cache, 45 W)

681284-001

 Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W)

702840-001

 Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W)

681283-001

 Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W)

702081-001

 Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-
MHz FSB, 6.0-MB L3 cache, 45 W)

680646-001

 For use on all computer models:

 Intel Quad Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 35 W)

710787-001

 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 35 W)

681954-001

 Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

708762-001
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Item Component Spare part number

 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681953-001

 Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

708761-001

 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681952-001

 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

711903-001

 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

680645-001

 Intel Core i3-3130M 2.60-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 713163-001

 Intel Core i3-3120M 2.50-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 700627-001

 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 Intel Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001

 Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) 664663-001

(13) Fan (includes cable) 641839-001

(14) Memory modules (PC3-12800, 1666-MHz, DDR3):

 8-GB 670034-001

 4-GB locked 707248-001

 4-GB 641369-001

 2-GB 652972-001

(15) WWAN module:

 HP hs2350 HSPA+ Mobile Broadband Module 710788-001

 HP un2430 EV-DO/HSPA Mini Card 702080-001

 HP un2430 EV-DO/HSPA Mini Card 702080-001

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

(16) Heat sink (includes replacement thermal material):

 For use only on computer models equipped with a graphics subsystem with
discrete memory

686021-001

 For use only on computer models equipped with a graphics subsystem with
UMA memory

693371-001

(17) Optical drive (includes optical drive bezel and optical drive bracket):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 Blu-ray R/RE DVD±RW SuperMulti DL Drive 686048-001

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689090-001

 DVD±RW Double-Layer with SuperMulti Drive 689078-001
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Item Component Spare part number

 DVD-ROM Drive 689076-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689079-001

 DVD±RW Double-Layer with SuperMulti Drive 689077-001

 DVD-ROM Drive 689075-001

(18) Hard drive (does not include hard drive bracket or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws) 642774-001

(19) Speaker assembly (includes cable) 641840-001

(20) Bluetooth module 4.0 EDR

NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number
641830-001.

655792-001

(21) Battery (Li ion):

 9-cell, 100-Wh, 3.00-Ah 631243-001

 9-cell, 100-Wh, 3.00-Ah 634087-001

 9-cell, 73-Wh, 2.20-Ah 634089-001

 6-cell, 62-Wh, 2.80-Ah 628670-001

 6-cell, 62-Wh, 2.80-Ah 628668-001

 6-cell, 51-Wh, 2.55-Ah 659083-001

 3-cell, 31-Wh, 2.80-Ah 628664-001

(22) Base enclosure (includes rubber feet, service cover release latch assembly, and
battery release latch assembly)

685997-001

 Rubber Kit (not illustrated, includes display bezel left and right rubber screw covers,
base enclosure front and rear rubber screw covers, top cover rubber bumper)

642768-001

 Latch Kit (not illustrated, includes service cover release latch assembly components
and battery release latch assembly components)

684339-001

(23) Service cover:

 Includes label indicating “Made in China” 686031-001

 Includes label indicating country of origin 699325-001
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel:

 For use only on HP EliteBook 8470w Mobile Workstation computer models 686014-001

 For use only on HP EliteBook 8470p Notebook PC computer models 686012-001

(2) Webcam/microphone module 686045-001
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Item Component Spare part number

 Microphone module 642798-001

(3) Display Hinge Kit (includes left and right display hinges and left and right hinge
brackets)

642782-001

 Display Hinge Cover Kit, includes: 686024-001

(4a) Display hinge outer covers (2)

(4b) Display hinge inner covers (2)

(4c) Display hinge tube

(5) 15.6-in, LED, AntiGlare display panel:

 14.0-in, LED, FLT, HD+, AntiGlare display panel 686047-001

 14.0-in, LED, FLT, HD, AntiGlare display panel 686046-001

 14.0-in, LED, SVA, HD+, AntiGlare display panel 684348-001

 14.0-in, LED, SVA, HD, AntiGlare display panel 684347-001

 Display Cable Kit, includes:

(6a) Display panel cable:

(6b) Webcam/microphone module cable:

 For use only on HP EliteBook 8470w Mobile Workstation computer models equipped
with an HD+ display assembly

686019-001

 For use only on HP EliteBook 8470w Mobile Workstation computer models equipped
with an HD display assembly

686017-001

 For use only on HP EliteBook 8470p Notebook PC computer models equipped with
an HD+ display assembly

686018-001

 For use only on HP EliteBook 8470p Notebook PC computer models equipped with
an HD display assembly

686016-001

 Antenna Kit, includes: 685993-001

(7) WWAN antenna cables and transceivers

(8) WLAN antenna cables and transceivers

(9) Display enclosure:

 For use only on HP EliteBook 8470w Mobile Workstation computer models 685996-001

 For use only on HP EliteBook 8470p Notebook PC computer models 685995-001

 Display Panel Support Kit (includes WLAN antenna cables and transceivers, WWAN antenna cables and
transceivers, and display enclosure)

 For use in HP EliteBook 8470w Mobile Workstation computer models 686023-001

 For use in HP EliteBook 8470p Notebook PC computer models 686022-001

 Display Rubber Kit (includes display bezel rubber screw covers and display bezel
rubber bumpers)

642785-001
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 641830-001

(1) Bluetooth module cable

(2) TouchPad board cable

(3) RJ-11 jack cable
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Mass storage devices

Item Description Spare part number

(1) Hard drive (does not include hard drive bracket or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm SED 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit, includes: 642774-001

(2) Hard drive bracket
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Item Description Spare part number

 Hard drive bracket screws (not illustrated)

(3) Optical drive (includes optical drive bezel and optical drive bracket):

 For use only on HP EliteBook 8470w Mobile Workstation computer models:

 Blu-ray R/RE DVD±RW SuperMulti DL Drive 686048-001

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689090-001

 DVD±RW Double-Layer with SuperMulti Drive 689078-001

 DVD-ROM Drive 689076-001

 For use only on HP EliteBook 8470p Notebook PC computer models:

 Blu-ray ROM DVD±RW SuperMulti DL Drive 689079-001

 DVD±RW Double-Layer with SuperMulti Drive 689077-001

 DVD-ROM Drive 689075-001

(4) Upgrade bay cradle 643921-001

(5) Solid-state drive (does not include solid-state drive bracket or screws):  

 256-GB SATA III self-encrypting solid-state drive 691466-001

 256-GB SATA III Samsung solid-state drive 709167-001

 240-GB SATA III solid-state drive 702242-001

 180-GB SATA III solid-state drive 692097-001

 160-GB SATA II solid-state drive 693863-001

 128-GB SATA III solid-state drive 700626-001

 128-GB SATA III solid-state drive 690229-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit:

 For use only on HP EliteBook 8470w Mobile Workstation computer models: 686963-001

 For use only on HP EliteBook 8470p Notebook PC computer models: 686027-001

 Includes:

(1) RJ-11 jack plug

(2) ExpressCard slot space saver

(3) Optical drive bay space saver
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Miscellaneous parts

Component Spare part number

AC adapter:

90-W HP Smart AC adapter (PFC, EM, 3-wire) 693713-001

90-W HP Smart AC adapter (PFC, 3-wire) 693712-001

65-W HP Smart AC adapter (non-PFC, 3-wire) 693711-001

65-W HP Smart AC adapter (RC/V, EM, 3-wire) 693710-001

Carrying case:

HP basic carrying case 455084-001

HP essential nylon case 612757-001

HP professional top-load slim case 592923-001

Lock:

HP notebook computer combination lock 591699-001

HP notebook computer keyed cable lock 626729-001

Optical mouse:

HP USB optical travel mouse 434594-001

HP USB/PS2 2-button optical mouse 390632-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in Thailand 490371-201

44 Chapter 3   Illustrated parts catalog



Component Spare part number

For use in the United Kingdom and Singapore 490371-031

Screw Kit 686032-001

Sequential part number listing

Spare part number Description

390632-001 HP USB/PS2 2-button optical mouse

434594-001 HP USB optical travel mouse

455084-001 HP basic carrying case

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

572511-001 Intel Centrino Ultimate-N 6300 WLAN module

591699-001 HP notebook computer combination lock

592923-001 HP professional top load slim case

612757-001 HP essential nylon case

626729-001 HP notebook computer keyed cable lock

628664-001 3-cell, 31-Wh, 2.80-Ah, Li-ion battery

628668-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery

628670-001 [a] 6-cell, 55h, 2.80-Ah, Li-ion battery
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628824-001 Modem module (does not include the RJ-11 jack cable)

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number 641830-001.

631243-001 9-cell, 100-Wh, 3.0-Ah, Li-ion battery

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

634087-001 9-cell, 100-Wh, 3.00-Ah, Li-ion battery

634089-001 6-cell, 73-Wh, 2.20-Ah, Li-ion battery

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634862-001 320-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

641830-001 Cable Kit (includes Bluetooth module cable, RJ-11 jack cable, and TouchPad cable)

641839-001 Fan (includes cable)

641840-001 Speaker assembly (includes cable)

642768-001 Rubber Kit (includes rubber bumpers)

642774-001 Hard Drive Hardware Kit (includes hard drive bracket and screws)

642782-001 Display Hinge Kit (includes left and right hinges and left and right hinge brackets)

642785-001 Display Rubber Kit (includes display bezel rubber screw covers and display bezel rubber
bumpers)

642798-001 Microphone module

643921-001 Upgrade bay cradle

651948-001 RTC battery (includes cable and double-sided tape)

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

655792-001 Bluetooth module 4.0 EDR (does not include the Bluetooth module cable)

NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 641830-001.

659083-001 6-cell, 51-Wh, 2.55-Ah, Li-ion battery

664663-001 Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W; includes
replacement thermal material)

669832-001 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

670288-001 Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter
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675793-001 HP lt2523 LTE/HSPA+ Mobile Broadband Module

675794-001 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter

680645-001 Intel Dual Core i5-3210M 2.50-GHz processor for use only on HP EliteBook 8470p Notebook PC
computer models (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

680646-001 Intel Quad Core i7-3610QM 2.30-GHz processor for use on all computer models (SC turbo up to
3.30-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W; includes replacement thermal material)

681283-001 Intel Quad Core i7-3720QM 2.60-GHz processor for use on all computer models (SC turbo up to
3.60-GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W; includes replacement thermal material)

681284-001 Intel Quad Core i7-3820QM 2.70-GHz processor for use only on HP EliteBook 8470w Mobile
Workstation computer models (SC turbo up to 3.70-GHz; 1600-MHz FSB, 8.0-MB L3 cache,
45 W; includes replacement thermal material)

681952-001 Intel Dual Core i5-3320M 2.60-GHz processor for use on all computer models (SC turbo up to
3.30-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

681953-001 Intel Dual Core i5-3360M 2.80-GHz processor for use on all computer models (SC turbo up to
3.50-GHz; 1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement thermal material)

681954-001 Intel Dual Core i7-3520M 2.90-GHz processor for use on all computer models (SC turbo up to
3.60-GHz; 1600-MHz FSB, 4.0-MB L3 cache, 35 W; includes replacement thermal material)

682417-001 Intel Core i3-3110M 2.40-GHz processor for use only on HP EliteBook 8470p Notebook PC
computer models (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes replacement
thermal material)

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket or screws)

NOTE: The hard drive bracket and screws are included in the Hard Drive Hardware Kit, spare
part number 642774-001.

684339-001 Latch Kit (includes service cover release latch assembly components and battery release latch
assembly components)

684340-001 Display lid switch board

684343-001 Fingerprint reader board (includes cable)

684345-001 ExpressCard assembly

684347-001 14.0-in, LED, SVA, HD, AntiGlare display panel

684348-001 14.0-in, LED, SVA, HD+, AntiGlare display panel

685993-001 Antenna Kit (includes left and right WLAN antenna cables and transceivers and left and right
WWAN antenna cables and transceivers)

685995-001 Display enclosure for use only on HP EliteBook 8470p Notebook PC computer models

685996-001 Display enclosure for use only on HP EliteBook 8470w Mobile Workstation computer models

685997-001 Base enclosure (includes four rubber feet, service cover release latch assembly, and battery
release latch assembly)

686012-001 Display bezel for use only on HP EliteBook 8470p Notebook PC computer models

686014-001 Display bezel for use only on HP EliteBook 8470w Mobile Workstation computer models

686016-001 Display panel cable for use only on HP EliteBook 8470p Notebook PC computer models equipped
with an HD display assembly
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686017-001 Display panel cable for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with an HD display assembly

686018-001 Display panel cable for use only on HP EliteBook 8470p Notebook PC computer models equipped
with an HD+ display assembly

686019-001 Display panel cable for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with an HD+ display assembly

686021-001 Heat sink for use on computer models equipped with a graphics subsystem with discrete memory

686022-001 Display Panel Support Kit for use only on HP EliteBook 8470p Notebook PC computer models
(includes display enclosure, WLAN antenna cables and transceivers, and WWAN antenna cables
and transceivers)

686023-001 Display Panel Support Kit for use only on HP EliteBook 8470w Mobile Workstation computer
models (includes display enclosure, WLAN antenna cables and transceivers, and WWAN antenna
cables and transceivers)

686024-001 Display Hinge Cover Kit (includes hinge tube, left and right hinge covers, cable guides, left and
right inner covers, and left and right outer covers)

686025-001 Smart Card reader

686027-001 Plastics Kit for use only on HP EliteBook 8470p Notebook PC computer models (includes
ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack cover, and wireless
antenna clips)

686031-001 Service cover (includes label indicating “Made in China”)

686032-001 Screw Kit

686040-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with UMA memory and the Windows 7 operating system in all countries and
regions except the People's Republic of China and the Ukraine (includes replacement
thermal material)

686040-501 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with UMA memory and the Windows 8 Standard operating system in all
countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

686040-601 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with UMA memory and the Windows 8 Professional operating system in all
countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

686041-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with discrete memory and the Windows 7 operating system in all countries
and regions except the People's Republic of China and the Ukraine (includes replacement
thermal material)

686041-501 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with discrete memory and the Windows 8 Standard operating system in all
countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

686041-601 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with discrete memory and the Windows 8 Professional operating system in
all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)
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686042-001 System board for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with a graphics subsystem with discrete memory and the Windows 7 operating system
in all countries and regions except the People's Republic of China and the Ukraine (includes
replacement thermal material)

686042-501 System board for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with a graphics subsystem with discrete memory and the Windows 8 Standard
operating system in all countries and regions except the People's Republic of China and
the Ukraine (includes replacement thermal material)

686042-601 System board for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with a graphics subsystem with discrete memory and the Windows 8 Professional
operating system in all countries and regions except the People's Republic of China and
the Ukraine (includes replacement thermal material)

686043-001 Top cover with pointing stick buttons and a fingerprint reader for use only on HP EliteBook 8470w
Mobile Workstation computer models (includes TouchPad)

686045-001 Webcam/microphone module (includes double-sided tape)

686046-001 14.0-in, LED, FLT, HD, AntiGlare display panel

686047-001 14.0-in, LED, FLT, HD+, AntiGlare display panel

686048-001 Blu-ray R/RE DVD±RW SuperMulti DL Drive (for use only on HP EliteBook 8470w Mobile
Workstation computer models; includes bezel and bracket)

686299-001 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in the United States (includes keyboard cable and
pointing stick cable)

686299-031 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

686299-041 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Germany (includes keyboard cable and
pointing stick cable)

686299-051 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in France (includes keyboard cable and pointing
stick cable)

686299-061 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Italy (includes keyboard cable and pointing
stick cable)

686299-071 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Spain (includes keyboard cable and pointing
stick cable)

686299-081 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Denmark (includes keyboard cable and pointing
stick cable)

686299-091 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Norway (includes keyboard cable and pointing
stick cable)

686299-131 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Portugal (includes keyboard cable and pointing
stick cable)
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686299-141 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Turkey (includes keyboard cable and pointing
stick cable)

686299-161 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Latin America (includes keyboard cable and
pointing stick cable)

686299-171 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

686299-201 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Brazil (includes keyboard cable and pointing
stick cable)

686299-211 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Hungary (includes keyboard cable and pointing
stick cable)

686299-251 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Russia (includes keyboard cable and pointing
stick cable)

686299-261 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

686299-271 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Romania (includes keyboard cable and pointing
stick cable)

686299-281 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Thailand (includes keyboard cable and pointing
stick cable)

686299-291 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Japan (includes keyboard cable and pointing
stick cable)

686299-A41 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Belgium (includes keyboard cable and pointing
stick cable)

686299-AB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

686299-AD1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in South Korea (includes keyboard cable and
pointing stick cable)

686299-B31 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

686299-B71 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

686299-BA1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Slovenia (includes keyboard cable and pointing
stick cable)
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686299-BB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Israel (includes keyboard cable and pointing
stick cable)

686299-BG1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

686299-D61 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in India (includes keyboard cable and pointing
stick cable)

686299-DB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Canada (includes keyboard cable and pointing
stick cable)

686299-DD1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Iceland (includes keyboard cable and pointing
stick cable)

686299-DJ1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Greece (includes keyboard cable and pointing
stick cable)

686299-FB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

686299-FL1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 7 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

686300-001 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in the United States (includes keyboard cable and
pointing stick cable)

686300-031 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

686300-041 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Germany (includes keyboard cable and
pointing stick cable)

686300-051 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in France (includes keyboard cable and pointing
stick cable)

686300-061 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Italy (includes keyboard cable and pointing
stick cable)

686300-071 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Spain (includes keyboard cable and pointing
stick cable)

686300-081 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Denmark (includes keyboard cable and pointing
stick cable)

686300-091 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Norway (includes keyboard cable and pointing
stick cable)
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686300-131 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Portugal (includes keyboard cable and pointing
stick cable)

686300-141 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Turkey (includes keyboard cable and pointing
stick cable)

686300-161 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Latin America (includes keyboard cable and
pointing stick cable)

686300-171 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

686300-201 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Brazil (includes keyboard cable and pointing
stick cable)

686300-211 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Hungary (includes keyboard cable and pointing
stick cable)

686300-251 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Russia (includes keyboard cable and pointing
stick cable)

686300-261 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

686300-271 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Romania (includes keyboard cable and pointing
stick cable)

686300-281 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Thailand (includes keyboard cable and pointing
stick cable)

686300-291 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Japan (includes keyboard cable and pointing
stick cable)

686300-A41 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Belgium (includes keyboard cable and pointing
stick cable)

686300-A81 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

686300-AB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

686300-AD1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in South Korea (includes keyboard cable and
pointing stick cable)

686300-B31 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)
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686300-B71 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

686300-BA1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

686300-BB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Israel (includes keyboard cable and pointing
stick cable)

686300-BG1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

686300-D61 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in India (includes keyboard cable and pointing
stick cable)

686300-DB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Canada (includes keyboard cable and pointing
stick cable)

686300-DD1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Iceland (includes keyboard cable and pointing
stick cable)

686300-DJ1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Greece (includes keyboard cable and pointing
stick cable)

686300-FP1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 7 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

686963-001 Plastics Kit for use on HP EliteBook 8470w Mobile Workstation computer models (includes
ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack plug, and wireless
antenna clips)

686964-001 Top cover with pointing stick buttons for use only on HP EliteBook 8470p Notebook PC computer
models equipped with a fingerprint reader (includes TouchPad)

686965-001 Top cover with pointing stick buttons for use only on HP EliteBook 8470p Notebook PC computer
models not equipped with a fingerprint reader (includes TouchPad)

689075-001 DVD-ROM Drive for use only on HP EliteBook 8470p Notebook PC computer models (includes
bezel and bracket)

689076-001 DVD-ROM Drive for use only on HP EliteBook 8470w Mobile Workstation computer models
(includes bezel and bracket)

689077-001 DVD±RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8470p Notebook PC
computer models (includes bezel and bracket)

689078-001 DVD±RW Double-Layer with SuperMulti Drive for use only on HP EliteBook 8470w Mobile
Workstation computer models (includes bezel and bracket)

689079-001 Blu-ray ROM DVD±RW SuperMulti DL Drive for use only on HP EliteBook 8470p Notebook PC
computer models (includes bezel and bracket)

689080-001 Blu-ray ROM DVD±RW SuperMulti DL Drive for use only on HP EliteBook 8470w Mobile
Workstation computer models (includes bezel and bracket)

689954-001 24-GB flash cache module
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690229-001 128-GB SATA III solid-state drive

691466-001 256-GB SATA III self-encrypting solid-state drive

691716-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with UMA memory in the People's Republic of China and the Ukraine
(includes replacement thermal material)

691717-001 System board for use only on HP EliteBook 8470p Notebook PC computer models equipped with
a graphics subsystem with discrete memory in the People's Republic of China and the Ukraine
(includes replacement thermal material)

691718-001 System board for use only on HP EliteBook 8470w Mobile Workstation computer models
equipped with a graphics subsystem with discrete memory in the People's Republic of China and
the Ukraine (includes replacement thermal material)

692097-001 180-GB SATA III solid-state drive

693371-001 Heat sink for use only on computer models equipped with a graphics subsystem with UMA
memory (includes replacement thermal material)

693710-001 65-W HP Smart AC adapter (RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, 3-wire)

693712-001 90-W HP Smart AC adapter (PFC, 3-wire)

693713-001 90-W HP Smart AC adapter (PFC, EM, 3-wire)

693863-001 160-GB SATA II solid-state drive

695915-001 Intel Centrino Advanced-N 6205 Combo Adapter

699325-001 Service cover (includes label indicating country of origin)

700626-001 128-GB SATA III solid-state drive

700627-001 Intel Core i3-3120M 2.50-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

702080-001 HP un2430 EV-DO/HSPA Mini Card

702081-001 Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W; includes replacement thermal material)

702242-001 240-GB SATA III solid-state drive

702649-001 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in the United States (includes keyboard cable and
pointing stick cable)

702649-031 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

702649-041 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Germany (includes keyboard cable and
pointing stick cable)

702649-051 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in France (includes keyboard cable and pointing
stick cable)

702649-061 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Italy (includes keyboard cable and pointing
stick cable)
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Spare part number Description

702649-071 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Spain (includes keyboard cable and pointing
stick cable)

702649-081 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Denmark (includes keyboard cable and pointing
stick cable)

702649-091 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Norway (includes keyboard cable and pointing
stick cable)

702649-131 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Portugal (includes keyboard cable and pointing
stick cable)

702649-141 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Turkey (includes keyboard cable and pointing
stick cable)

702649-151 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Greece (includes keyboard cable and pointing
stick cable)

702649-161 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Latin America (includes keyboard cable and
pointing stick cable)

702649-171 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

702649-201 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Brazil (includes keyboard cable and pointing
stick cable)

702649-211 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Hungary (includes keyboard cable and pointing
stick cable)

702649-251 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Russia (includes keyboard cable and pointing
stick cable)

702649-261 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

702649-271 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Romania (includes keyboard cable and pointing
stick cable)

702649-281 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Thailand (includes keyboard cable and pointing
stick cable)

702649-291 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Japan (includes keyboard cable and pointing
stick cable)

702649-A41 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system Belgium (includes keyboard cable and pointing
stick cable)
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Spare part number Description

702649-AB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

702649-AD1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system South Korea (includes keyboard cable and
pointing stick cable)

702649-B31 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

702649-B71 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

702649-BA1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

702649-BB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Israel (includes keyboard cable and pointing
stick cable)

702649-BG1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

702649-D61 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in India (includes keyboard cable and pointing
stick cable)

702649-DB1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Canada (includes keyboard cable and pointing
stick cable)

702649-DD1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Iceland (includes keyboard cable and pointing
stick cable)

702649-FL1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

702649-FP1 Keyboard with pointing stick for use on HP EliteBook 8470w Mobile Workstation computer models
equipped with the Windows 8 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

702651-001 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in the United States (includes keyboard cable and
pointing stick cable)

702651-031 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in the United Kingdom and Singapore (includes
keyboard cable and pointing stick cable)

702651-041 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Germany (includes keyboard cable and
pointing stick cable)

702651-051 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in France (includes keyboard cable and pointing
stick cable)
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Spare part number Description

702651-061 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Italy (includes keyboard cable and pointing
stick cable)

702651-071 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Spain (includes keyboard cable and pointing
stick cable)

702651-081 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Denmark (includes keyboard cable and pointing
stick cable)

702651-091 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Norway (includes keyboard cable and pointing
stick cable)

702651-131 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Portugal (includes keyboard cable and pointing
stick cable)

702651-141 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Turkey (includes keyboard cable and pointing
stick cable)

702651-151 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Greece (includes keyboard cable and pointing
stick cable)

702651-161 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Latin America (includes keyboard cable and
pointing stick cable)

702651-171 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Saudi Arabia (includes keyboard cable and
pointing stick cable)

702651-201 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Brazil (includes keyboard cable and pointing
stick cable)

702651-211 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Hungary (includes keyboard cable and pointing
stick cable)

702651-251 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Russia (includes keyboard cable and pointing
stick cable)

702651-261 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Bulgaria (includes keyboard cable and pointing
stick cable)

702651-271 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Romania (includes keyboard cable and pointing
stick cable)

702651-281 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Thailand (includes keyboard cable and pointing
stick cable)

702651-291 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Japan (includes keyboard cable and pointing
stick cable)
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Spare part number Description

702651-A41 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system Belgium (includes keyboard cable and pointing
stick cable)

702651-AB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Taiwan (includes keyboard cable and pointing
stick cable)

702651-AD1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system South Korea (includes keyboard cable and
pointing stick cable)

702651-B31 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in the Netherlands (includes keyboard cable and
pointing stick cable)

702651-B71 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Sweden and Finland (includes keyboard cable
and pointing stick cable)

702651-BA1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Slovenia (includes keyboard cable and pointing
stick cable)

702651-BB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Israel (includes keyboard cable and pointing
stick cable)

702651-BG1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Switzerland (includes keyboard cable and
pointing stick cable)

702651-D61 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in India (includes keyboard cable and pointing
stick cable)

702651-DB1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Canada (includes keyboard cable and pointing
stick cable)

702651-DD1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Iceland (includes keyboard cable and pointing
stick cable)

702651-FL1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in the Czech Republic and Slovakia (includes
keyboard cable and pointing stick cable)

702651-FP1 Keyboard with pointing stick for use on HP EliteBook 8470p Notebook PC computer models
equipped with the Windows 8 operating system in Northwest Africa (includes keyboard cable and
pointing stick cable)

702840-001 Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W; includes replacement thermal material)

703266-001 Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80-GHz; 1600-MHz FSB, 8.0-
MB L3 cache, 45 W; includes replacement thermal material)

707248-001 4-GB locked memory module (PC3, 12800, 1600-MHz)

708761-001 Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

708762-001 Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)
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709167-001 256-GB SATA III Samsung solid-state drive

710787-001 Intel Quad Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W; includes replacement thermal material)

710788-001 HP hs2350 HSPA+ Mobile Broadband Module

711903-001 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

713163-001 Intel Core i3-3130M 2.60-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

60 Chapter 4   Removal and replacement procedures



Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
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CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V

64 Chapter 4   Removal and replacement procedures



Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 73 screws that must be removed, replaced, and/or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
number provided on the service tag. It is necessary to remove the battery to obtain these numbers.
See Battery on page 67 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

Component replacement procedures 65



Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 642768-001. There are 4 rectangular rubber feet (1) and two square rubber feet (2) that
attach to the base enclosure and service cover in the locations illustrated below.
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Battery

Description Spare part number

9-cell, 100-Wh, 3.00-Ah, Li ion 631243-001

9-cell, 100-Wh, 3.00-Ah, Li ion 634087-001

9-cell, 73-Wh, 2.20-Ah, Li ion 634089-001

6-cell, 62-Wh, 2.80-Ah, Li ion 628670-001

6-cell, 62-Wh, 2.80-Ah, Li ion 628668-001

6-cell, 51-Wh, 2.55-Ah, Li ion 659083-001

3-cell, 31-Wh, 2.80-Ah, Li ion 628664-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.
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Install the battery by inserting it into the battery bay until you hear a click.

SIM

NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service cover

Description Spare part number

Includes label indicating “Made in China” 686031-001

Includes label indicating country of origin 699325-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

Remove the service cover:

1. Slide the release latch (1) and remove the locking screw (if installed) (2).

2. Slide the release latch (3) to disengage the door from the computer.

3. Slide the door toward the front of the computer (4), and then lift the door off the computer (5).

Reverse the removal procedures to install the service cover.
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Smart Card reader

Description Spare part number

Smart Card reader 686025-001

Before removing the Smart Card reader, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the Smart Card reader:

1. Disconnect the Smart Card reader cable (1) from the low insertion force (LIF) connector on the
system board.

2. Use the Smart Card reader tab (2) to lift the left side of the Smart Card reader (3) and swing it up
and to the right.

3. Detach the clips (4) on the right side of the Smart Card reader from the base enclosure.

4. Remove the Smart Card reader by sliding it up and the left at an angle (5).

Reverse the removal procedures to install the Smart Card reader.
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Optical drive

NOTE: The optical drive spare part kit includes an optical drive bezel and optical drive bracket.

Description Spare part number

For use only on HP EliteBook 8470w Mobile Workstation computer models:

Blu-ray R/RE DVD±RW SuperMulti DL Drive 686048-001

Blu-ray ROM DVD±RW SuperMulti DL Drive 689090-001

DVD±RW Double-Layer with SuperMulti Drive 689078-001

DVD-ROM Drive 689076-001

For use only on HP EliteBook 8470p Notebook PC computer models:

Blu-ray ROM DVD±RW SuperMulti DL Drive 689079-001

DVD±RW Double-Layer with SuperMulti Drive 689077-001

DVD-ROM Drive 689075-001

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the optical drive:

1. Position the computer upside-down with the right side toward you.

2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

3. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to
release the optical drive.
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4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bezel, use a thin tool or an unbent paper clip (1) to
release the optical drive tray.

6. Use a flat-blade screw driver or similar tool to press on the optical drive bezel tab (2), and then
release the left side of the optical drive bezel (3).

7. Remove the optical drive bezel (4).

8. If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

9. Remove the three Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the
optical drive.
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10. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Upgrade bay cradle

Description Spare part number

Upgrade bay cradle 643921-001

Before removing the upgrade bay cradle, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the upgrade bay cradle:

1. Position the computer upside-down with the right side toward you.
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2. Remove the four Phillips PM2.0×4.0 screws that secure the upgrade bay cradle to the computer.

3. Loosen the captive Phillips screw that secures the upgrade bay cradle in the upgrade bay (1).

4. Use a flat-blade screw driver or similar tool to press on the upgrade bay bracket tab (2) to
release the upgrade bay.

5. Remove the upgrade bay (3) from the computer.

Reverse this procedure to install the upgrade bay.
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Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.

Description Spare part number

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit (includes hard drive bracket and screws) 642774-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

6. Remove the Smart Card reader (see Smart Card reader on page 70).

Remove the hard drive:

1. Loosen the three Phillips screws (1) that secure the hard drive to the computer.

2. Use the hard drive tab (2) to slide the hard drive to the right to disconnect it from the
system board.
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3. Remove the hard drive (3) from the hard drive bay.

4. If it is necessary to disassemble the hard drive, perform the following steps:

a. Remove the four Phillips PM3.0×3.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive. The hard drive bracket and screws
are available in the Hard Drive Hardware Kit, spare part number 642774-001.

Reverse this procedure to reassemble and install the hard drive.
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Memory module

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number

8-GB memory module (PC3, 12800, 1600-MHz) 670034-001

4-GB locked memory module (PC3, 12800, 1600-MHz) 707248-001

4-GB memory module (PC3, 12800, 1600-MHz) 641369-001

2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then click
Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

NOTE: The computer uses two memory slots. The top slot houses the expansion memory
module and is shown in the first image below. The bottom slot houses the primary memory
module and is shown in the second image below.

Reverse this procedure to install a memory module.
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WWAN module

NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP hs2350 HSPA+ Mobile Broadband Module 710788-001

HP un2430 EV-DO/HSPA Mini Card 702080-001

HP un2430 EV-DO/HSPA Mini Card 702080-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the WWAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
system board. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WWAN antennas are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

Intel Centrino Advanced-N 6205 Combo Adapter 695915-001

Intel Centrino Ultimate-N 6300 WLAN module 572511-001

Intel Centrino Wireless-N 2200 802.11b/g/n 2×2 WiFi Adapter 670288-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN
antenna cable connects to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
system board. (The WLAN module tilts up.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 641830-001.

Description Spare part number

Bluetooth module 4.0 EDR 655792-001

Before removing the Bluetooth module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Release the Bluetooth module (2) from the clip built into the base enclosure.

3. Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Modem module

NOTE: The modem module spare part kit does not include an RJ-11 jack cable. The RJ-11 jack
cable is included in the Cable Kit, spare part number 641830-001.

Description Spare part number

Modem module 628824-001

Before removing the modem module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the modem module:

1. Remove the two Phillips PM2.0×3.0 screws (1) that secure the modem module to the
system board.

2. Disconnect the modem module (2) from the system board by lifting it straight up.

3. Disconnect the RJ-11 jack cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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Fan

Description Spare part number

Fan (includes cable) 641839-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Loosen the captive Phillips screw (2) that secures the fan to the top cover.

3. Remove the Phillips PM2.5×5.0 screw (3) that secures the fan to the top cover.

4. Remove the fan (4).

Reverse this procedure to install the fan.
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Keyboard

For use in country/region Spare part
number

For use in country/region Spare part
number

Keyboard with pointing stick for use only on HP EliteBook 8470w Mobile Workstation computer models
(includes keyboard cable and pointing stick cable):

For use only on computer models equipped with the
Windows 8 operating system:

For use in the Netherlands 702649-B31

For use in Belgium 702649-A41 For use in Norway 702649-091

For use in Brazil 702649-201 For use in Northwest Africa 702649-FP1

For use in Bulgaria 702649-261 For use in Portugal 702649-131

For use in Canada 702649-DB1 For use in Romania 702649-271

For use in the Czech Republic
and Slovakia

702649-FL1 For use in Russia 702649-251

For use in Denmark 702649-081 For use in Saudi Arabia 702649-171

For use in France 702649-051 For use in Slovenia 702649-BA1

For use in Germany 702649-041 For use in South Korea 702649-AD1

For use in Greece 702649-151 For use in Spain 702649-071

For use in Hungary 702649-211 For use in Sweden and Finland 702649-B71

For use in Iceland 702649-DD1 For use in Switzerland 702649-BG1

For use in India 702649-D61 For use in Taiwan 702649-AB1

For use in Israel 702649-BB1 For use in Thailand 702649-281

For use in Italy 702649-061 For use in Turkey 702649-141

For use in Japan 702649-291 For use in the United Kingdom
and Singapore

702649-031

For use in Latin America 702649-161 For use in the United States 702649-001

For use only on computer models equipped with the
Windows 7 operating system:

For use in the Netherlands 686300-B31

For use in Belgium 686300-A41 For use in Norway 686300-091

For use in Brazil 686300-201 For use in Northwest Africa 686300-FP1

For use in Bulgaria 686300-261 For use in Portugal 686300-131

For use in Canada 686300-DB1 For use in Romania 686300-271

For use in the Czech Republic
and Slovakia

686300-A81 For use in Russia 686300-251

For use in Denmark 686300-081 For use in Saudi Arabia 686300-171

For use in France 686300-051 For use in Slovenia 686300-BA1

For use in Germany 686300-041 For use in South Korea 686300-AD1

For use in Greece 686300-DJ1 For use in Spain 686300-071

For use in Hungary 686300-211 For use in Sweden and Finland 686300-B71
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For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Iceland 686300-DD1 For use in Switzerland 686300-BG1

For use in India 686300-D61 For use in Taiwan 686300-AB1

For use in Israel 686300-BB1 For use in Thailand 686300-281

For use in Italy 686300-061 For use in Turkey 686300-141

For use in Japan 686300-291 For use in the United Kingdom
and Singapore

686300-031

For use in Latin America 686300-161 For use in the United States 686300-001

Keyboard with pointing stick for use only on HP EliteBook 8470p Notebook PC computer models
(includes keyboard cable and pointing stick cable):

For use only on computer models equipped with the
Windows 8 operating system:

For use in the Netherlands 702651-B31

For use in Belgium 702651-A41 For use in Norway 702651-091

For use in Brazil 702651-201 For use in Northwest Africa 702651-FP1

For use in Bulgaria 702651-261 For use in Portugal 702651-131

For use in Canada 702651-DB1 For use in Romania 702651-271

For use in the Czech Republic
and Slovakia

702651-FL1 For use in Russia 702651-251

For use in Denmark 702651-081 For use in Saudi Arabia 702651-171

For use in France 702651-051 For use in Slovenia 702651-BA1

For use in Germany 702651-041 For use in South Korea 702651-AD1

For use in Greece 702651-151 For use in Spain 702651-071

For use in Hungary 702651-211 For use in Sweden and Finland 702651-B71

For use in Iceland 702651-DD1 For use in Switzerland 702651-BG1

For use in India 702651-D61 For use in Taiwan 702651-AB1

For use in Israel 702651-BB1 For use in Thailand 702651-281

For use in Italy 702651-061 For use in Turkey 702651-141

For use in Japan 702651-291 For use in the United Kingdom
and Singapore

702651-031

For use in Latin America 702651-161 For use in the United States 702651-001

For use only on computer models equipped with the
Windows 7 operating system:

For use in the Netherlands 686299-B31

For use in Belgium 686299-A41 For use in Norway 686299-091

For use in Brazil 686299-201 For use in Northwest Africa 686299-FB1

For use in Bulgaria 686299-261 For use in Portugal 686299-131

For use in Canada 686299-DB1 For use in Romania 686299-271

For use in the Czech Republic
and Slovakia

686299-FL1 For use in Russia 686299-251
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For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Denmark 686299-081 For use in Saudi Arabia 686299-171

For use in France 686299-051 For use in Slovenia 686299-BA1

For use in Germany 686299-041 For use in South Korea 686299-AD1

For use in Greece 686299-DJ1 For use in Spain 686299-071

For use in Hungary 686299-211 For use in Sweden and Finland 686299-B71

For use in Iceland 686299-DD1 For use in Switzerland 686299-BG1

For use in India 686299-D61 For use in Taiwan 686299-AB1

For use in Israel 686299-BB1 For use in Thailand 686299-281

For use in Italy 686299-061 For use in Turkey 686299-141

For use in Japan 686299-291 For use in the United Kingdom
and Singapore

686299-031

For use in Latin America 686299-161 For use in the United States 686299-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67).

5. Remove the service cover (see Service cover on page 69).
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Remove the keyboard:

1. Loosen the three Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its right side.

3. Partially open the computer.

4. Insert a screw driver or similar thin tool into the keyboard release opening in the battery bay, and
then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.
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6. Lift the rear edge of the keyboard (1), and then swing the keyboard up and forward (2) until it
rests upside down on the palm rest.

7. Release the zero insertion force (ZIF) connector to which the pointing stick cable is attached,
and then disconnect the pointing stick cable (1) from the keyboard.

8. Release the ZIF connector (2) to which the keyboard cable is attached, and then disconnect the
keyboard cable (3) from the system board.

9. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Base enclosure

Description Spare part number

Base enclosure (includes four rubber feet, service cover release latch assembly, and battery
release latch assembly)

685997-001

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

NOTE: When replacing the base enclosure, be sure to remove the following components from the
defective base enclosure and install them on the replacement base enclosure:

● Bluetooth module and cable (see Bluetooth module on page 83)

● Speaker assembly (see Speaker assembly on page 94)

● RJ-11 jack assembly (see RJ-11 jack cable on page 96)

Remove the base enclosure:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the four rubber screw covers (1). The rubber screw covers are included in the Rubber
Kit, spare part number 642768-001.

4. Remove the eight Torx PM2.5×8.0 screws (2) that secure the base enclosure to the computer.
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5. Remove the two Phillips PM2.5×11.0 screws from the docking connector alignment guides (3)
that secure the base enclosure to the computer.

6. Remove the following screws that secure the base enclosure to the computer:

(1) One Phillips PM2.0×3.0 screw from the hard drive bay

(2) Two Phillips PM2.0×3.0 screws from the battery bay

(3) One Phillips PM2.0×4.0 broad head screw from the battery bay

(4) Two Phillips PM2.5×4.5 screws from the optical drive bay

7. Position the computer with the battery bay toward you.

8. Remove the four Torx TM2.5×8.0 screws (1) from the rear panel of the computer.
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9. Disconnect the speaker cable from the system board connector (2).

10. Remove the bottom cover from the computer.

NOTE: Thoroughly clean the thermal pad material from the surfaces of the base enclosure (1) and
the PCH chip (2) each time you remove the base enclosure. All base enclosure and system board
spare part kits include replacement thermal pad material.
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Reverse this procedure to install the base enclosure.

Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 641840-001

Before removing the speaker assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)

Remove the speaker assembly:

1. Turn the base enclosure right-side up, with the front toward you.
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2. Release the speaker cable (1) from the clips (2) and routing channel built into the
base enclosure. Note that the cable routes from inside the base enclosure to outside the base
enclosure.

3. Turn the base enclosure upside down, with the front toward you.

4. Remove the two Phillips PM2.0×5.0 screws (1) that secure the speaker assembly to the
base enclosure.

5. Remove the speaker assembly (2) from the base enclosure.

Reverse this procedure to install the speaker assembly.
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RJ-11 jack cable

NOTE: The RJ-11 jack cable is included in the Cable Kit, spare part number 641830-001.

Before removing the RJ-11 jack cable, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)

Remove the RJ-11 jack cable:

1. Turn the base enclosure right-side up, with the front toward you.

2. Release the RJ-11 jack from the clip (1) built into the base enclosure.
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3. Release the RJ-11 jack cable from the clips (2) and routing channel built into the
base enclosure.

4. Remove the RJ-11 jack cable.

Reverse this procedure to install the RJ-11 jack cable.

Service cover release latch assembly

NOTE: The service cover release latch assembly components are included in the Latch Kit, spare
part number 684339-001.

Before removing the service cover release latch assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)
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Remove the service cover release latch assembly:

1. Position the base enclosure with the front toward you.

2. Remove the service cover release latch actuator from the base enclosure.

3. Turn the base enclosure upside down, with the front toward you.

4. Remove the service cover release latch arm spring from the spring retention hooks on the
service cover release latch arm (1) and the base enclosure (2).

5. Slide the service cover release latch arm (1) as far to the left as it will go.

6. Flex the middle of the service cover release latch arm (2) up and back until it releases from the
track built into the base enclosure.
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7. Lift the left end of the service cover release latch arm (3) out of the openings in the
base enclosure.

8. Swing the left end of the service cover release latch arm (1) toward the back of the computer.

9. Release the right end of the service cover release latch arm (2) from the openings in the
base enclosure.

10. Remove the service cover release latch arm.

Reverse this procedure to install the service cover release latch assembly.
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Battery release latch assembly

NOTE: The battery release latch assembly components are included in the Latch Kit, spare part
number 684339-001.

Before removing the battery release latch assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)

Remove the battery release latch assembly:

1. Position the base enclosure with the front toward you.

2. Remove the battery release latch actuator from the base enclosure.

3. Turn the base enclosure upside down, with the front toward you.
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4. Remove the battery release latch arm spring from the spring retention hooks on the
base enclosure (1) and the battery release latch arm (2).

5. Slide the battery release latch arm (1) as far to the right as it will go.

6. Lift the right end of the battery release latch arm (2) until it is clear of the retention post built into
the base enclosure.

7. Swing the right end of the battery release latch arm (3) clockwise until it is clear of the retention
post built into the base enclosure.

8. Slide the battery release latch arm (1) as far to the left as it will go.
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9. Swing the right end of the battery release latch arm (2) clockwise until the left end of the arm
release from the openings in the base enclosure.

10. Remove the battery release latch arm.

Reverse this procedure to install the battery release latch assembly.

Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes cable) 684343-001

Before removing the fingerprint reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)
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Remove the fingerprint reader board:

1. Position the computer with the front toward you.

2. Disconnect the fingerprint reader board cable (1) from the LIF connector on the system board.

3. Detach the fingerprint reader board (2) from the clips built into the top cover.

4. Remove the fingerprint reader board and cable.

Reverse this procedure to install the fingerprint reader board.
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RTC battery

Description Spare part number

RTC battery (includes cable and double-sided tape) 652650-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the TouchPad.

2. Detach the RTC battery (2) from the TouchPad. (The RTC battery is attached to the TouchPad
with double-sided tape.)

3. Remove the RTC battery.
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Reverse this procedure to install the RTC battery.

Display lid switch board

Description Spare part number

Display lid switch board (includes cable) 684340-001

Before removing the display lid switch board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Modem module (see Modem module on page 84)

f. Keyboard (see Keyboard on page 86)

g. Base enclosure (see Base enclosure on page 91)

Remove the display lid switch board:

1. Position the computer with the front toward you.

2. Disconnect the display lid switch board cable (1) from the LIF connector on the system board.
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3. Detach the display lid switch board (2) from the clips built into the top cover.

4. Remove the display lid switch board and cable.

Reverse this procedure to install the display lid switch board and cable.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP EliteBook 8470w Mobile Workstation computer models:

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 8 Professional operating system in all countries and regions except the
People's Republic of China and the Ukraine

686042-601

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 8 Standard operating system in all countries and regions except the People's
Republic of China and the Ukraine

686042-501

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 7 operating system in all countries and regions except the People's Republic of
China and the Ukraine

686042-001

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 7 operating system in the People's Republic of China and the Ukraine

691718-001

For use only on HP EliteBook 8470p Notebook PC computer models:

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 8 Professional operating system in all countries and regions except the
People's Republic of China and the Ukraine

686041-601

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 8 Standard operating system in all countries and regions except the People's
Republic of China and the Ukraine

686041-501

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 7 operating system in all countries and regions except the People's Republic of
China and the Ukraine

686041-001

For use only on computer models equipped with a graphics subsystem with discrete memory
and the Windows 7 operating system in the People's Republic of China and the Ukraine

691717-001

For use only on computer models equipped with a graphics subsystem with UMA memory and
the Windows 8 Professional operating system in all countries and regions except the People's
Republic of China and the Ukraine

686040-601

For use only on computer models equipped with a graphics subsystem with UMA memory and
the Windows 8 Standard operating system in all countries and regions except the People's
Republic of China and the Ukraine

686040-501

For use only on computer models equipped with a graphics subsystem with UMA memory and
the Windows 7 operating system in all countries and regions except the People's Republic of
China and the Ukraine

686040-001

For use only on computer models equipped with a graphics subsystem with UMA memory and
the Windows 7 operating system in the People's Republic of China and the Ukraine

691716-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.
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3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Smart Card reader (see Smart Card reader on page 70)

c. Optical drive (see Optical drive on page 71)

d. Hard drive (see Hard drive on page 75)

e. Fan (see Fan on page 85)

f. Modem module (see Modem module on page 84)

g. Fan (see Fan on page 85)

h. Keyboard (see Keyboard on page 86)

i. Base enclosure (see Base enclosure on page 91)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● SIM (see SIM on page 68, if applicable)

● Memory module (see Memory module on page 77)

● WWAN module (see WWAN module on page 79)

● WLAN module (see WLAN module on page 81)

● Heat sink (see Heat sink on page 110)

● Processor (see Processor on page 114)

Remove the system board:

1. Release the wireless antenna cables (1) from the routing clips (2) attached to the system board.
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2. Disconnect the following cables from the system board:

(3) Display lid switch board cable

(4) Display panel cable

(5) Webcam/microphone module cable

(6) Fingerprint reader cable

(7) RTC battery cable

3. Remove the three Phillips PM2.5×4.0 screws that secure the system board to the top cover.

4. Flex the right side of the top cover (1) until the connectors on the right side of the system board
are clear.

5. Lift the right side of the system board (2) until it rests at an angle.
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6. Remove the system board (3) by sliding it up and to the right at an angle.

Reverse this procedure to install the system board.

Heat sink

NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number

For use only on computer models equipped with a graphics subsystem with discrete memory 686021-001

For use only on computer models equipped with a graphics subsystem with UMA memory 693371-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Hard drive (see Hard drive on page 75)

c. Optical drive (see Hard drive on page 75)

d. WLAN module (see WLAN module on page 81)

e. WWAN module (see WWAN module on page 79)

f. Fan (see Fan on page 85)
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g. Keyboard (see Keyboard on page 86)

h. Base enclosure (see Base enclosure on page 91)

i. System board (see System board on page 107)

Remove the heat sink:

NOTE: Steps 1 and 2 apply to computer models equipped with a graphics subsystem with discrete
memory. See steps 3 and 4 for heat sink removal information for computer models equipped with a
graphics subsystem with UMA memory.

1. Following the 1, 2, 3, 4, 5, 6 sequence stamped into the heat sink, loosen the six captive Philllips
screws (1) and (2) that secure the heat sink to the system board.

2. Remove the heat sink (3).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: Steps 3 and 4 apply to computer models equipped with a graphics subsystem with
UMA memory. See steps 1 and 2 for heat sink removal information for computer models
equipped with a graphics subsystem with discrete memory.

3. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.

4. Remove the heat sink (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and the system board components each time the heat sink is removed. Replacement thermal
material is included with the heat sink, processor, and system board spare part kits.

The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with discrete memory.

● Thermal paste is used on the processor (1) and the heat sink section (2) that services it

● A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it

The following illustration shows the replacement thermal material locations on a computer model
equipped with a graphics subsystem with UMA memory. Thermal paste is used on the
processor (1) and the heat sink section (2) that services it.
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Reverse this procedure to install the heat sink.
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Processor

NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number

For use only on HP EliteBook 8470w Mobile Workstation computer models:

Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80-GHz; 1600-MHz FSB, 8.0-
MB L3 cache, 45 W)

703266-001

Intel Quad Core i7-3820QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 8.0-
MB L3 cache, 45 W)

681284-001

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W)

702840-001

Intel Quad Core i7-3720QM 2.60-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W)

681283-001

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W)

702081-001

Intel Quad Core i7-3610QM 2.30-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 6.0-
MB L3 cache, 45 W)

680646-001

For use on all computer models:

Intel Quad Core i7-3540M 3.00-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W)

710787-001

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W)

681954-001

Intel Dual Core i5-3380M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

708762-001

Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681953-001

Intel Dual Core i5-3340M 2.70-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

708761-001

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681952-001

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.20-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

711903-001

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

680645-001

Intel Core i3-3130M 2.60-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 713163-001

Intel Core i3-3120M 2.50-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 700627-001

Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

For use only on HP EliteBook 8470p Notebook PC computer models:

Intel Core i3-2370M 2.40-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, 35 W) 677152-001

Intel Celeron B840 1.90-GHz processor (1333-MHz FSB, 2.0-MB L3 cache, 35 W) 664663-001
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Before removing the processor, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Hard drive (see Hard drive on page 75)

c. Optical drive (see Hard drive on page 75)

d. WLAN module (see WLAN module on page 81)

e. WWAN module (see WWAN module on page 79)

f. Fan (see Fan on page 85)

g. Keyboard (see Keyboard on page 86)

h. Base enclosure (see Base enclosure on page 91)

i. System board (see System board on page 107)

j. Heat sink (see System board on page 107)

Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.
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2. Lift the processor (2) straight up, and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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ExpressCard assembly

Description Spare part number

ExpressCard assembly 684345-001

Before removing the ExpressCard assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Hard drive (see Hard drive on page 75)

c. Optical drive (see Hard drive on page 75)

d. WLAN module (see WLAN module on page 81)

e. WWAN module (see WWAN module on page 79)

f. Fan (see Fan on page 85)

g. Keyboard (see Keyboard on page 86)

h. Base enclosure (see Base enclosure on page 91)

i. System board (see System board on page 107)

Remove the ExpressCard assembly:

1. Release the ZIF connector (1) to which the ExpressCard assembly cable is attached, and then
disconnect the ExpressCard assembly cable from the TouchPad board.

2. Release the ZIF connector (2) to which the TouchPad cable is attached, and then disconnect the
TouchPad cable from the ExpressCard assembly.
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3. Release the ExpressCard assembly cable from the clips (3) built into the top cover.

4. Remove the Phillips PM2.0×4.0 screw (1) that secures the ExpressCard assembly to the
top cover.

5. Remove the ExpressCard assembly (2).

Reverse this procedure to install the ExpressCard assembly.
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Display assembly

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

Before removing the display assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 67), and then remove the following components:

a. Service cover (see Service cover on page 69)

b. Hard drive (see Hard drive on page 75)

c. Optical drive (see Hard drive on page 75)

d. WLAN module (see WLAN module on page 81)

e. WWAN module (see WWAN module on page 79)

f. Fan (see Fan on page 85)

g. Keyboard (see Keyboard on page 86)

h. Base enclosure (see Base enclosure on page 91)

Remove the display assembly:

1. Disconnect the display panel cable (1) and the webcam/microphone module cable (2) from the
system board.

2. Release the display panel cable and the webcam/microphone module cable from the routing
channel (3) attached to the system board.
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3. Release the wireless antenna cables (1) from the routing channel (2) attached to the
system board.

4. Remove the two Phillips PM2.5×4.5 screws (1) that secure the display assembly to the top
cover.

5. Swing the display hinges (2) back until the top cover is free for removal.

6. Press the display release latch (3) to release the display assembly from the top cover.

7. Remove the computer (4) from the display assembly.

8. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the rubber screw covers (1). The rubber screw covers are available in the Display
Rubber Kit, spare part number 642785-001.

b. Remove the two Phillips PM2.5×5.0 screws (2) that secure the display bezel to the
display assembly.
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c. Flex the inside edges of the bottom edge (3), the left and right sides (4), and the
top edge (5) of the display bezel until the bezel disengages from the display enclosure.

d. Remove the display bezel (6). The display bezel is available using spare part numbers
686014-001 (for use only on HP EliteBook 8470w Mobile Workstation computer models)
and 686012-001 (for use only on HP ProBook 8470p Notebook PC computer models).

9. If it is necessary to replace the display hinges:

a. Remove the four Phillips PM2.0×3.0 screws (1) that secure the display hinge assemblies to
the display enclosure.

b. Remove the display hinge assemblies (2) from the display enclosure.

c. Remove the display hinge outer cover (3).

d. Remove the display hinge and inner cover (4) from the display enclosure.

Component replacement procedures 121



e. Remove the display hinge outer cover (5) from the hinge.

f. Remove the two Phillips PM2.0×3.0 screws (1) that secure the display hinge tube to the
display enclosure.

g. Release the display hinge tube (2) by sliding it away from the display enclosure.

h. Release the wireless antenna cables (3), display panel cable (4), and webcam/microphone
cable (5) from the display hinge tube, noting of the locations of the display cable guides (6)
at the left and right ends of the display hinge tube.

i. Remove the display hinge tube. The display hinge tube, display hinge inner covers, display
hinge outer covers, and display cable guides are available in the Display Hinge Cover Kit,
spare part number 686024-001.

The display hinges are available using spare part number 642782-001.
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10. If it is necessary to replace the display panel:

a. Remove the four Phillips PM2.0×4.0 screws (1) that secure the display panel to the
display enclosure.

b. Remove the display panel (2) from the display enclosure. The display panel is available
using the following spare part numbers.

● 686047-001 — 14.0-in, LED, FLT, HD+, AntiGlare display panel

● 686046-001 — 14.0-in, LED, FLT, HD, AntiGlare display panel

● 684348-001 — 14.0-in, LED, SVA, HD+, AntiGlare display panel

● 684347-001 — 14.0-in, LED, SVA, HD, AntiGlare display panel

11. If it is necessary to replace the display panel cable:

a. Turn the display panel upside down, with the display panel cable toward you.

b. Detach the display panel cable (1) from the display panel rear surface.

c. Release the adhesive support strip (2) that secures the display panel cable to the
display panel.
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d. Disconnect the display panel cable (3) from the display panel.

e. Remove the display panel cable. The display panel cable is included in the Display Panel
Kit, spare part numbers:

● 686019-001 — For use only on HP EliteBook 8470w Mobile Workstation computer
models equipped with an HD+ display assembly

● 686017-001 — For use only on HP EliteBook 8470w Mobile Workstation computer
models equipped with an HD display assembly

● 686018-001 — For use only on HP EliteBook 8470p Notebook PC computer models
equipped with an HD+ display assembly

● 686016-001 — For use only on HP EliteBook 8470p Notebook PC computer models
equipped with an HD display assembly

12. If it is necessary to replace the webcam/microphone module and cable:

a. Release the shielding tabs (1) that secure the webcam/microphone module to the
display enclosure.

b. Detach the webcam/microphone module (2) from the display enclosure. (The webcam/
microphone module is attached to the display enclosure with double-sided tape.)

c. Disconnect the webcam/microphone module cable (3) from the webcam/
microphone module.

CAUTION: Handle the webcam/microphone module with caution. The module has a thin
profile and is susceptible to damage when not handled carefully.

d. Detach the webcam/microphone module cable from the contact points (4) on the
display enclosure.
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e. Remove webcam/microphone module cable (5). The webcam/microphone module is
available using spare part number 686045-001. The microphone module is available using
spare part number 642798-001.

13. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Release the WLAN antenna cables from the clips (1) and routing channel built into the
display enclosure.

b. Detach the WLAN antenna transceivers (2) from the display enclosure. (The WLAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685993-001.
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14. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Release the WWAN antenna cables from the clips (1) and routing channel built into the
display enclosure.

b. Detach the WWAN antenna transceivers (2) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685993-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and Advanced
System Diagnostics

Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

Windows 8 127



NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes:

Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

● To save your changes and exit Computer Setup menus:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing
fn+esc (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update

CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the
AC adapter. Do not download or install a BIOS update while the computer is running on battery
power, docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type h, and then select Help and Support.

2. In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3. At the download area, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive.

Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.

NOTE: If you connect your computer to a network, consult the network administrator
before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. From the Start screen, type e, and then click File Explorer.

2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

● BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: NOTE: you need to stop a diagnostics test while it is running, press esc.

Windows 8 131



Windows 7
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful
installation, download and install a BIOS update only when the computer is connected to reliable
external power using the AC adapter. Do not download or install a BIOS update while the computer is
running on battery power, docked in an optional docking device, or connected to an optional power
source. During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer
and access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.
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6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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SuSE Linux (SLED)
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the
computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.
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– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently
installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful
installation, download and install a BIOS update only when the computer is connected to reliable
external power using the AC adapter. Do not download or install a BIOS update while the computer is
running on battery power, docked in an optional docking device, or connected to an optional power
source. During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your web browser. For U.S. support, go to http://www.hp.com/go/contactHP. For
worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you
want to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer
and access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.
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Using Advanced System Diagnostics

Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer
hardware is functioning properly. The following diagnostic tests are available in Advanced System
Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start the
computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the
start-up test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if
necessary. If the battery fails the test, contact support to report the issue and purchase a
replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the
main components are functioning correctly. System Tune-Up runs longer and more
comprehensive tests on memory modules, hard drive SMART attributes, the hard drive surface,
the battery (and battery calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 33.80 cm 13.31 in

Depth 23.13 cm 9.11 in

Height (front to back) 3.18 to 3.38 cm 1.25 to 1.33 in

Weight

HP EliteBook 8470w Mobile Workstation:

Equipped with 9-cell battery, optical drive, one memory
module, WLAN module, and solid-state drive

2.25 kg 4.96 lbs

Equipped with 9-cell battery, one memory module,
WLAN module, and solid-state drive

2.39 kg 5.27 lbs

Equipped with 6-cell battery, optical drive, one memory
module, WLAN module, and solid-state drive

2.41 kg 5.31 lbs

Equipped with 6-cell battery, one memory module,
WLAN module, and solid-state drive

2.55 kg 5.62 lbs

HP EliteBook 8470w Mobile Workstation:

Equipped with 9-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, and solid-state drive

2.51 kg 5.53 lbs

Equipped with 9-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module, and
solid-state drive

2.37 kg 5.23 lbs

Equipped with 6-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, and solid-state drive

2.35 kg 5.18 lbs

Equipped with 6-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module, and
solid-state drive

2.21 kg 4.87 lbs

Equipped with 3-cell battery, optical drive, graphics
subsystem with UMA memory, one memory module,
WLAN module, and solid-state drive

2.21 kg 4.87 lbs
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 Metric U.S.

Equipped with 3-cell battery, graphics subsystem with
UMA memory, one memory module, WLAN module, and
solid-state drive

2.07 kg 4.56 lbs

Input power

Operating voltage and current 18.5 V dc @ 3.5 A - 65 W

– or –

19.0 V dc @ 4.74 A - 90 W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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14.0-inch WGA display specifications

 Metric U.S.

Dimensions

Height 17.6 cm 6.93 in

Width 31.2 cm 12.28 in

Diagonal 35.7 cm 14.06 in

Number of colors up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format HD+, WVA (1600 x 1900)

HD, SVA (1366 x 768)

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 3.46 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 750-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Length 100.2 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 110 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 1.5 ms 1.5 ms

Average (read/write) 12/16 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms

Logical blocks 1,465,149,168 976,773,168 628,142,448

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.

Hard drive specifications 143



7 Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of your
computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed
options.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information. From the Start screen, type h, and then select Help and Support.

Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system
repair media and your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. As you add new software and data files, you should continue to back up
your system on a regular basis to maintain a reasonably current backup. The system repair media
(select models only) are used to start up (boot) the computer and repair the operating system in case
of system instability or failure. Your initial and subsequent backups allow you to restore your data and
settings if a failure occurs.

From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.

You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see the
“Using Windows 8 operating system media (purchased separately)” section.

Using the Windows recovery tools

To recover information you previously backed up:

▲ From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition and the Windows partition.

From the Start screen, type e, and then click File Explorer.

– or –

From the Start screen, type c, and then select Computer.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see the “Using
Windows 8 operating system media (purchased separately)” section.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select
Help and Support.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: From the Start screen, type c,
and then select Computer.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see the “Using Windows 8 operating system
media (purchased separately)” section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using Windows 8 operating system media (purchased separately)

To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on
the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 8 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 8 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery

When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.

IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.

NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on
reinstalling traditional applications. From the Start screen, type h, and then select Help and Support.

NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.

To start Refresh:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Refresh your PC without affecting your files, select Get started, and follow the on-
screen instructions.
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Remove everything and reinstall Windows

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, apps, and settings from your computer, and reinstalls Windows.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key or from the Start screen.

To use the f11 key:

1. Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

2. Select Troubleshoot from the boot options menu.

3. Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:

1. On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2. Click Settings.

3. Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4. Under Remove everything and reinstall Windows, select Get started, and follow the on-
screen instructions.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or
deleted from the system.

1. From the Start screen, type HP Software Setup, and select Apps.

2. Open HP Software Setup.

3. Follow the on-screen directions to reinstall drivers or select software.

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only)
with the installed optical drive (select models only) or an optional external optical drive, or create
system restore points. In case of system failure, you can use the backup files to restore the contents
of your computer.
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Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them
for later use.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP
Recovery Disc Creator. This recovery media allows you to reinstall your original operating system as
well as select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information

Recovery after a system failure is as good as your most recent backup. Immediately after setting up
the computer, you should create system repair discs (select models only) using the installed optical
drive (select models only) or an optional external optical drive and back up your system. As you add
new software and data files, you should continue to back up your system on a regular basis to
maintain a reasonably current backup. The system repair discs (select models only) are used to start
up (boot) the computer and repair the operating system in case of system instability or failure. Your
initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:
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NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select
models only), or create a system repair disc (select models only).

Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, see the
Using a Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select
models only), or your files.

To recover your information using Startup Repair, follow these steps:

CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the
hard drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that
were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

152 Chapter 7   Backup and recovery



Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/us/en/
wwcontact_us.html. You can also order the DVD by calling support. For contact information, see the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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SuSE Linux (SLED)
Recovery after a system failure is as good as your most recent backup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if
ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see the
“Performing a system recovery” section.

2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can
manually back up your information to an optional external drive, a network drive, or discs. Back up
your system at the following times:

● At regularly scheduled times

● Before the computer is repaired or restored

● Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click
Backup my home directory.

2. Click Storage Destination Location, and then select a location to back up your information.

3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled
time.

To immediately back up your information, click the Backup Now check box.

NOTE: Before you back up your information, be sure you have designated a location to save
the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

1. Select Computer > More Applications > Tools > Backup Manager Restore.

2. Click Backup Source, and then select the location of the backup files.

3. Click Restore Destination, and then select the destination to restore the files.

4. To restore all files from the selected location, click Restore all files. To restore select files only,
click Restore selected files, click Select Files and then select the files to be restored.
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5. Under Restore Point, click the time and date of the backup.

NOTE: If multiple backups have been performed, click Use the latest version to restore the
latest version.

6. Click Restore to start restoring the files, or click Cancel to cancel the operation.

Performing a system recovery

Recovery allows you to repair or restore the computer to its original factory state. You can create an
HP Factory Image Restore DVD, using an installed or an external DVD±RW optical drive.

CAUTION: CAUTION: Using Recovery completely erases hard drive contents and reformats the
hard drive. All files you have created and any software installed on the computer are permanently
removed. The recovery tool reinstalls the original operating system and HP programs and drivers that
were installed at the factory. Software, drivers, and updates not installed by HP must be manually
reinstalled. Personal files must be restored from a backup.

To restore the computer using the HP Factory Image Restore DVD, you must first create the recovery
disc. To create the recovery disc:

NOTE: HP recommends that you create the HP Factory Image Restore DVD in the event of a
system failure.

1. Select Computer > More Applications.

2. In the left pane, click Tools, and then click Create HP Factory Image Restore DVD in the right
pane.

3. Follow the on-screen instructions to create an image file to burn a recovery disc.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.

2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.

3. As the computer is restarting, press f9 to open the Computer Setup boot option menu.

4. Press the down arrow to select Restore SLED HP-BNB preload image from the Linux boot
menu, and then press enter.

5. Using the arrow keys, select Yes when prompted: Do you want to start the System-Restore?

6. Follow the on-screen instructions.
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USB Recovery option (select models only)

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the
SLED operating system installed on select HP Business Notebooks. This Disk On Key may be used
to restore the system to the original factory state when the F11 recovery option is not available. This
process should be done on first obtaining the computer.

CAUTION: The USB recovery option does not preserve data present on the computer’s hard drive
or on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the
notebook that will be recovered before starting.

NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure.
The Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key

1. Connect the USB Disk On Key to a USB port on the computer.

2. Select Computer > More applications > Tools > Create Recovery USB.

3. Enter the root password when prompted.

4. Select USB Disk On Key from the list.

5. Click OK.

6. A question dialog will remind you that the data on the USB key will be destroyed. To continue,
click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another
computer.

7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the
key is mounted. You may close the file browser window if desired. Once the USB Recovery Key
has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be
recovered has been backed up. The recovery process destroys all data on the system to be
recovered.

1. Turn off the computer.

2. Connect the USB Disk On Key to a USB port on the computer.

3. Turn on the computer while holding down the f9 key.

4. Once the system has booted, the Boot Options menu should appear.

5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical
Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On
Key.

6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk
On Key will boot.
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7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start
the System-Restore?” If data on the computer has not been backed up, use the tab key and
select No. The system will reboot. Back up the system data and repeat the previous steps. If no
data should be saved from the computer, use the tab key to select Yes. Press enter to begin the
recovery process.

8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall SLED

Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option
removes all personal data, applications, and settings from your computer, and reinstalls the Linux
operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.

You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and
preserves user data.

● Restore Factory System—This option restores the system back to the original factory state. User
data is not preserved.

Select an option and follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not
dispose of the battery in general household waste. Follow the local laws and regulations in your area
for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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